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Using the Guide 
MicroLog is a compact data logger used to monitor the 
temperature and humidity of perishable goods or controlled 
environments.   It can also be connected to external sensors 
in order to monitor additional parameters, and can be 
mounted onto a cradle for use with the Sound Alarm feature 
as well as the wireless Daily Download tool. 
 
MicroLog Plus is a sophisticated data logging system, which 
can remotely monitor up to 200 MicroLogs simultaneously. 
 
 Chapter 1 of this guide details the operation procedures for  
MicroLog as a stand-alone device, as well as how to work 
with its software program, MicroLab.  
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If you are using the wireless MicroLog Plus system read 
 Chapter 2, which details the setup and operation of the 
wireless MicroLog Plus system.  Chapter 3 explains how to 
use the MicroLog together with a cradle.  Chapter 4 covers 
connecting your MicroLog to a receiver.  Chapter 5 explains 
the use of external antenna, and  Chapter 6 deals with 
connecting it to external sensors.
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Compliance with FDA Title 21 CFR Part 11 
To achieve compliance with FDA Title 21 CFR Part 11, use 
Fourier Systems’ software packages: MicroLab or MicroLab 
Plus together with DatPass. The DatPass software is Fourier 
Systems’ administration software. Among other features, it 
defines the users that can log onto the MicroLab/MicroLab 
Plus software, their passwords and the digital signatures the 
users are permitted to sign data within electronic records 
(files). DatPass also maintains an audit trail to keep track of 
all action performed within the system. The system is 
secured with a serial port dongle, without which the MicroLab 
and DatPass software packages will not operate. 
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Chapter 1 MicroLog 
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1.1. Overview 
MicroLog can be used as a stand-alone device to monitor 
temperature and humidity levels. All viewing, exporting and 
printing of the data obtained is done with just two keys. 
MicroLog continuously displays the most recent recordings, 
along with the maximum and minimum values for a selected 
time interval. Users can also define minimum and maximum 
alarm levels for a specific shipment, and the display screen 
will begin to flash if either level is breached. 
(Instructions for using the Sound Alarm feature can be found 
in section  0) 
The data stored by MicroLog can be downloaded to any 
computer for further viewing and analysis using the MicroLab 
software, and can be exported to a spreadsheet. 
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1.2. Getting Started 
In order to save battery life, MicroLog is shipped in Stop 
Mode. This means that before you can start recording, you 
must first connect MicroLog to the PC and set it up with the 
accompanying software. To set up MicroLog with the 
MicroLab software, refer to section  1.4. 
Once MicroLog receives the setup command, it begins 
logging the data immediately. 
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1.3. Working with MicroLog 

1.3.1. Data Displays 

Current data 
When MicroLog is recording, the data from the sensors is 
displayed alternately. The data obtained from external 
sensors is displayed with a small EXT symbol. 
When MicroLog stores the data, the LCD display briefly 
changes to a “double dash” (- -) symbol. 

Minimum and maximum values 
You can display minimum and maximum values for any hour 
from the last 24 hours and for any day from the last 30 days 
by using MicroLog’s left and right keys: 
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Viewing Min. and Max Values in the Last 1-24 Hours 
1. Select a time period by pressing the right 

key on the MicroLog. The LCD will begin 
displaying the hour number, ranging from 
hours 1 to 
24.  Once 
you’ve 
reached 
the desired 
time 
period, 
release the 
right key. 

 

MicroLog
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2. Once you’ve released the right key, 
MicroLog will display the Min and Max 
values logged by the sensors during the 
selected time period. 

3. (Optional) Once the left key is released, 
MicroLog will send an IR signal of the Min 
and Max values for the selected time 
period. To receive a printout of this data, 
simply point the MicroLog to the IR printer 
(HP portable printer – model No. 82240B). 

Viewing Min. and Max Values for the last 1-30 Days 
1. Select a time period by pressing the left 

key on the MicroLog. The LCD will display 
the day number, ranging from days 1 to 
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30. Once you’ve reached the desired time 
period, 
release the 
left key. 

 
2. Once the 

left key is 
released, 
MicroLog 
will display the Min and Max values of the 
sensors for the selected time period. 

3.  (Optional) Once the left key is released, 
the MicroLog will send an IR signal of the 
Min and Max values for the selected time 
period. To receive a printout of this data, 

MicroLog
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simply point MicroLog to the IR printer (HP 
portable printer – model No. 82240B). 

Status messages 
When both the left and right keys are pressed 
simultaneously, the MicroLog LCD will display MicroLog’s 
status. This will also “wake up” the device, a step necessary 
for its communication with a computer. The status messages 
include: 
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MicroLog

 

 
– Run  

  

 
– Cyclic Run 
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– Timer Run 

  

 
– Stop Mode 

  

 
– Downloading data to a PC 

1.3.2. Working Modes 
MicroLog is always set in one of the 4 possible modes: 
Stop – MicroLog is idle and is not recording. 
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Run – MicroLog is recording data. It will stop recording 
automatically when its memory is full (16,000 recordings). 
Cyclic Run – Same as Run, but MicroLog will record over 
the old data when the memory is full, beginning with the 
earliest data recording. 
Timer Run – MicroLog can be configured to start recording 
at a predetermined time. When MicroLog is set for such a 
run, its status is set to Timer Run. Once MicroLog starts 
recording, its status changes to either Run or Cyclic Run, 
depending on the desired configuration. 

1.3.3. MicroLog’s Connections 

Note: MicroLog ships with a rubber plug that covers the rear 
socket. The plug protects the socket from moisture. Unless 
you are using the socket leave the plug in.     
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Connect MicroLog to a computer 
For this you will need a serial communication cable (catalog 
number DT058). 
  

 

The serial communication cable 
ends with a type D 9-pin female 
plug. Plug this in to any free COM 
port on your computer. 
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The other end of the 
serial communication 
cable ends with a small 
black flat plug. Plug 
this end into the socket 
at the back of the 
MicroLog. 
Note that the socket 
has three pins, with 
one further away from 
the other two (Figure 
1). Take care to plug 
the cable in correctly. 
 

 
Figure 1: Connecting MicroLog 
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Note: You can also connect to the PC via the Cradle (see 
page 170). 

Connect MicroLog to an external sensor 
Use the same PC connection socket to connect to an 
external sensor (see Figure 1). 
Note that the socket has three pins, with one further away 
from the other two (Figure 1). Take care to plug the cable in 
correctly. 

Note: You can also connect the external sensor to the 
Cradle (see page 170). 
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1.3.4. Sleep Mode 
The MicroLog battery's maximum lifespan is approximately 
1.5 years. This long battery life is achieved by MicroLog 
putting itself "to sleep" between recordings, or after 4 
minutes goes by without communication with the computer. 
While sleeping the data logger consumes a minimal amount 
of power. 
MicroLog "wakes up" every second for a very short time (a 
few micro-seconds) to check if one of the keys has been 
pressed or if there is a message coming in from the 
computer. This is the reason you have to press and hold a 
key for at least two seconds before a status message 
appears.  
If you use high sampling rates, the MicroLog battery’s 
lifespan will be considerably shorter (see Figure 2). 



Chapter 1 MicroLog   

20 

16.4

12.1

5.9

0.8

24.624.424.123.3
21.5

0

5

10

15

20

25

30

0 5 10 15 20
Minutes between samples

D
ur

at
io

n 
of

 w
or

ki
ng

 in
 m

on
th

es

EC650
EC600

 
Figure 2: MicroLog battery life 

Note: The figures on the graph refer to MicroLog usage without daily 
download and without viewing min/max values on MicroLog's display 
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1.3.5. Replacing the Battery  
Warning: The back cover of the MicroLog contains a special 
compartment for the fragile humidity sensor. When removing 
or replacing the cover, be careful not to harm the sensor. 

+

 
Figure 3: Replacing the battery 

Humidity 
sensor 

Humidity 
sensor 
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MicroLog’s battery is a 1/2AA 3.6V lithium 
battery 

1. Unfasten the four screws on the back of 
the MicroLog. 

2. Carefully remove the back cover 
3. Replace the battery, and be sure to insert 

the new battery into the correct 
corresponding polarities  (look for the “+” 
symbol next to the positive terminal) 

4. Carefully reposition the electronic board on 
MicroLog’s back cover and make sure that 
the humidity sensor is placed in its 
compartment. 
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5. Refasten the four screws on the back of 
the MicroLog. 

1.4. Working with the MicroLab Software 

1.4.1. Installation 

System requirements 
To work with MicroLab, your system should be equipped with 
the following: 
Software 
Windows 95, or later (Windows 95 will not support USB) 
Internet Explorer 4.0, or later (you can install Internet 
Explorer 5 when you install MicroLog Plus, since it ships with 
the product). 
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Hardware 
Pentium 300 MHz or higher 
32 MB RAM (64 MB recommended) 
5 MB available disk space for the MicroLab application 

 Installing the software  
1. Insert the CD into your CD drive. 
2. The installation will start automatically. Once the 

process begins, follow the on-screen instructions. 
3. In case auto run is not working, open the CD drive 

folder and double-click the setup icon, then follow 
the on-screen instructions. 

To un-install the software: From the Start menu select 
Settings > Control Panel, and use the Add/Remove 
programs function to remove the MicroLab application. 
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To install the USB driver (optional for cradle 
communication): 

1. Insert the CD into your CD drive. If Installation 
begins automatically (and you have already 
installed MicroLab), click Cancel to stop installation 

2. Connect the Cradle to a USB port on your PC. 
Windows will automatically detect the new device 
and open the Add New Hardware Wizard 

3. Select Specify the location of the driver, then 
click Next 

4. Select Search for the best driver for your device, 
then check the Removable Media checkbox, and 
then click Next 

Windows will automatically detect and install the necessary 
software. 
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1.4.2. Overview 
The MicroLab software was designed to allow for the 
programming of the desired data recording specifications for 
MicroLog, to enable the downloading of recorded data to a 
PC, and to store, view and analyze the data. 
The Logger menu handles all communication between the 
PC and MicroLog such as programming the desired 
recording mode, starting or stopping data recording, as well 
as downloading the data. 
The View menu controls the various data display options. 
Data can be viewed in graph format, in table format, or in 
both. The Data Map is a separate pane that displays a list of 
the open data sets. It can also be used to quickly navigate 
through the data sets. 
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The Graph menu contains all the commands needed to 
format and edit the graph. 
The most common tasks and commands are available as 
buttons on the main toolbar and on the graph toolbar. 

1.4.3. Getting Started 

Downloading data 
1. Connect MicroLog to the PC 
2. Open the MicroLab software 

3. Click Download  on the main toolbar. 
Once the downloading has been completed, the data will be 
displayed both in the graph and in the table, and a new data 
icon will be added to the Data Map. 
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You can now connect a different MicroLog to the PC and 
download its data. The number of downloads is limited only 
by the memory available on the computer. 
Use the Data Map (section  0) to navigate between the 
different data sets. 

Saving data 

To save the displayed data, click Save  on the main 
toolbar. The data currently displayed by the graph will be 
saved in the MicroLog Data folder: 
C:\Program Files\Fourier Systems\MicroLog\MicroLog Data 
The data file name consists of the MicroLog name 
(Comment, see page 51) and of the time and date at which it 
was saved. 
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To save data in a different location or under a different name, 
use the Save as… command from the File menu: 

1. Select Save as… from the File menu. 
2. Enter a new name in the File name box 
3. To save the data in a different folder, select a drive 

and/or folder from the Save in box 
4. Click Save 

If you’ve downloaded data from more than one MicroLog and 
you want to save all the data sets, select Save all from the 
File menu. 
If you are using the Daily download option, data will be saved 
automatically. 
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Note: If you want to remove unwanted data before saving, 
apply the crop tool (see page 43). 

Opening files 

1. Click Open  on the main toolbar. 
2. To open a document that was saved in a different 

folder, select a drive and/or folder in the Look in 
box. 

3. Double-click the file you want to open. 

Display properties 
You can change the way numbers and dates will be 
displayed on screen. 
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1. Click File on the menu bar, and then click Display 
properties. 

2. In the Decimal place settings, enter the number of 
decimal places you want to display (enter a number 
between 0 and 4) for each sensor. 

3. In the Date format settings select the desired 
format option. 

4. Click OK. 
 

Printing a graph 

1. Click Print  on the main toolbar to open the 
Print Options dialog box. 

2. Click the graph option. 
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3. Click Print to open the Print Dialog Box. 
4. Click OK. 

Printing a table 
The displayed data can also be printed as a table. The table 
will only include data from sensors that are currently 
represented on the graph (to learn how to add or remove 
data sets from the graph, see page 35) as well as the 
MicroLog name, serial number and the alarm level setup. 
Data that exceeds any of the alarm levels will be highlighted 
by arrows.  

1. Click Print  on the main toolbar to open the 
Print Options dialog box. 

2. Click the Table option. 
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3. If you want to print only part of the data, uncheck 
the check box and select the desired time and date 
in the From and To boxes. 

4. Click the Print button to open the Print dialog box. 
5. Click OK. 

1.4.4. Viewing the Data 

Display options 
MicroLab’s screen consists of three parts: the graph, the 
table and the Data Map. You can display all three parts 
simultaneously (the default view) or any combination of 
them. 
If you are using the daily download option you can display a 
daily status window. 
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Graph 

Click Graph  to display or remove the graph. The graph 
displays the data sets plotted vs. time. The graph usually 
displays all the data sets of a given MicroLog, but you can 
use the Data Map to remove one or more of the sets from 
the graph (see section  0 in this chapter). 
In order to keep the graph clear and simple, only two Y-axes 
can be shown on the graph simultaneously. If there are three 
curves in the graph, one of the Y-axes will be hidden. To 
make this axis visible, select the corresponding plot with the 
cursor (see page 37). 
You can identify the Y-axis by its color, which matches the 
plot color. 
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Table 

Click Table  to display or remove the table. 
The data in the table always matches the data that is 
currently displayed on the graph.  

Data Map 

Click Data Map  to display or remove the Data Map. 
The Data Map is a separate window that displays the list of 
data sets that were downloaded or opened in the current 
session. Use the Data Map to navigate through the available 
plots and to keep track of the data that is being displayed in 
the graph and/or table windows. 
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When you double-click on a MicroLog icon  in the 
Document Map, MicroLab jumps to the corresponding data 
and displays it in the graph and table windows. It also 
expands the Data Map to show the individual sensors 
included with the selected MicroLog. 

A graph icon  indicates that the data set is currently being 
displayed. Double click on the icon to clear the data set from 
the display.  

An empty icon  indicates that the data set is not being 
displayed. Double click on the icon to add the data set to the 
display. 
To collapse the sensor list under an individual MicroLog, 
click the minus sign (-) next to the MicroLog icon.  
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To display the complete sensor list under an individual 
MicroLog, click the plus sign (+) next to the MicroLog icon. 
To remove an individual MicroLog from the Data Map, right-
click on its icon, then click Remove Data.  
To remove all data sets from the Data Map, right-click the 

Data sets icon , then click Remove All Data. 

The Cursor 
Use the cursor to view individual data recording values, or to 
reveal a hidden Y-axis. 
To display the cursor, double click on an individual data point 

or click Cursor  on the graph toolbar. You can drag the 
cursor with the mouse to any other point on the plot, or to 
another plot altogether. 
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The point coordinates of the selected data recording will 
appear in the status bar at the bottom of the graph window. 

Zooming and panning 
1. Zooming 

Click Zoom in  on the graph toolbar and drag the cursor 
diagonally to select the area you want to magnify. Release 
the mouse button to zoom in to the selected area. 
Click on the Zoom in button a second time to turn off the 
Zoom tool. 
 

2. Autoscale 

Click Autoscale button  on the graph toolbar for the full 
data display. 
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Double-click on an individual axis to auto scale it separately. 
 

3. Manual scaling 

• Click Graph properties  on the graph 
toolbar to open the Graph Properties 
dialog box. 

• Select the Scale tab, and choose the axis 
you want to scale in the select axis drop 
list. 

• Uncheck the Autoscale check box and 
enter the new values in the edit box 

• In the time axis, you can either enter the 
time and date manually, or select it with 
the up and down arrow buttons. 
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• Click OK. 

To restore auto scaling, click Autoscale .  
 

4. Default zooming 
If you usually need to view a specific time frame (i.e. 
workday hours) use the Default zooming tool. You can set 
the start and end time of the time span and then use it 
whenever you open a file or download data from the 
MicroLog. 
To set the default zoom: 

• Click Graph Properties  on the graph 
toolbar, then click Set Default Zoom. 

• Enter the start and end times, then click 
Set. 
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To zoom to the default zoom: 

• Click Graph Properties  on the graph 
toolbar. 

• Check the Use default zoom check box 
and click OK. 

Every file and every data recording you download will 
automatically open in the default zoom as long as the Use 
default zoom check box remains checked. 

To restore auto scaling click Autoscale . 
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5. The Stretch/Compress axis tool 
Move the cursor onto one of graph axes. The cursor icon 

changes to double arrow symbol (↔), indicating that you 
can stretch or compress the axis scale. Drag the symbol to 
the desired location. Repeat the procedure for the other axis 
if necessary. 

6. Panning 
Use the pan tool after zooming view any part of the graph 
that is outside the zoomed area. 

To do this, click Pan  on the graph toolbar, then click 
anywhere on the graph and drag the graph to view another 
area. 
Click Pan a second time to turn off the Pan tool. 
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Cropping the data 
Cropping enables you to trim the edges of a data set. Use it 
to remove unwanted data 

• Zoom to the data range you want to keep. 
• Click Graph on the menu bar, then click 

Crop. 
All data outside the zoomed area will be permanently 
removed. 

Formatting the graph 
You can change a data line’s color, style or width. You can 
also add markers that represent the data points on the graph 
and format their style and color. 



Chapter 1 MicroLog   

44 

The Y-axis color matches the corresponding plot’s color and 
will change accordingly. The time axis color can be changed 
separately: 

• Click Graph properties  on the graph 
toolbar to open the Graph Properties 
dialog box. 

• Select the Lines tab, then select the plot 
or axis you want to format in the select 
plot drop list. 

• From here you can format the line’s color, 
style and width, as well as the markers’ 
color and style. To remove the line or the 
marker, uncheck the corresponding visible 
check box. 
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• To restore the default formatting, click the 
Restore default button, and click OK 

Displaying alarm levels 

• Click Display alarm level . 

• Select the sensor you wish to display from 

the select sensor drop list 
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Changing the temperature units 

Click Toggle °C/°F button  to change the temperature 
scale from Fahrenheit to Celsius and vice versa.  
Note: To change the units in the MicroLog display, use the 
Setup dialog box (see page 50). 

Exporting data to Excel 

Click Export to Excel  to export the currently displayed 
data to an Excel spreadsheet. MicroLab will open a new 
Excel workbook displaying the data along with the MicroLog 
info, including the MicroLog name, serial number and alarm 
levels setup.  
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Copying the graph as a picture 
You can copy the graph to the clipboard as a picture and 
then paste it to other Windows programs such as Word and 
PowerPoint: 

1. On the Graph menu, click Copy graph. 
2. Open the destination file. 
3. In the destination file, right click and select Paste. 

Viewing more than one data set on the graph 
MicroLab lets you view more than one data set in Graph and 
Table view at the same time, allowing you to compare the 
data from several data sets side by side. 
Note: To use this feature the data sets must have been 
recorded using the same sampling rate e.g. every 1 minute 
There are two modes when using the Multi-graph feature: 
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• Standard mode 
The time scale of all data on the graph is the same. The time 
and date of data recorded in the first data set included on the 
graph is used.  
For example, if you have a graph whose data was recorded 
starting 10:00AM on August 11, then all additional data 
added to the graph will be displayed with the same recording 
date. 
 
The MicroLab data table below shows all data in the graph 
having the same time scale: 
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• Plot sync mode 
To display data on the graph using the data’s actual time 
scale i.e. the time and date when the data was actually 
recorded, use the Plot sync feature. This will also shift all 
data in the data table accordingly.  
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Once you’ve added the data to the graph, on the Graph 
menu, select Plot sync to enable the feature. To return to 
Standard mode, unselect Plot sync.  
 
Note: The time scale of all data is rounded to the same 
resolution as the time scale of the original data on the graph.  

1.4.5. Programming the MicroLog 

Setup 
Use the Setup dialog box to view or to change the MicroLog 
and the Cradle settings 
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Note: If you intend to setup more then one MicroLog or 
Cradle use the Save setup tool (see page 60).  

• Connect MicroLog or the Cradle to the PC 

• Click Setup  to open the Setup dialog 

box. 

The dialog box is made up of five sections: 

a. MicroLog info 

Comment  
 Click the Edit box and type a name that will serve to 

identify the specific MicroLog (e.g. its location). 
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S/N  
 Displays the MicroLog’s serial number 
Battery Level  
 If the indicator is in the red zone the battery should 

be replaced (see page 20). 

b. Cradle info 

Cradle ID  
 The cradle’s identification number sets the cradle’s 

transmission time in daily download mode. 
Battery Level  
 If the indicator is in the red zone the battery should 

be replaced (see page 173). 
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c. Setup 

Temperature  
 Click the Temperature check box to activate the 

internal temperature sensor 
Humidity  
 Click the Humidity check box to activate the internal 

humidity sensor 
External  
 Click on the External check box to activate the 

external sensor option, and then select a sensor in 
the drop list. 
If you want to use a sensor that is not found in the 
drop list, you can define new sensor (see page 68). 
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The sensors’ current readings will appear in the labels next 
to the sensor name once MicroLog begins logging for the 
first time. 
Temperature unit  
 To set the temperature unit in the MicroLog display, 

select the option you want (Celsius or Fahrenheit). 
Interval  
  

Determines the logging interval, or the time interval 
between successive data recordings. 
The time format is hh:mm:ss. Set the time setting to 
select a recording time interval from between 10 
seconds and 2 hours. For example, to set a time 
interval of one hour, five minutes and thirty seconds, 
click the hours (hh) and type 1 or use the arrows to 
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select 01, then click the minutes (mm) and type 5 or 
use the arrows, and finally, click the seconds (ss) 
and type 30 or select 30 using the arrows. 

  
Timer run  
 Click the Timer run check box if you want MicroLog 

to start recording at a predetermined time. This 
option is convenient if you are using several 
MicroLogs at once and want them to all begin 
logging at the same time. 
Use the time and date selectors to set the start time. 

Cyclic run  
 In Cyclic run mode, MicroLog overwrites the old 

measurements (starting with the oldest one) once 
the MicroLog’s memory is full. Click the Cyclic run 
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check box to operate in this mode.  
If the check box is clear, MicroLog will operate in 
Normal run mode and will stop recording when the 
memory is full. 

  
Daily download  
 Check the Daily download checkbox to enable 

automatic daily download (see page 72 for details). 
 

d. Alarm levels 

  
 Type in the desired minimum and maximum alarm 

levels. If MicroLog records a reading that exceeds 
either of these levels, the MicroLog’s LCD will start 
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to flash and the cradle’s alarm will sound. 
To stop the LCD’s flashing, press either of its two 
keys. To stop the cradle’s alarm, press both the 
MicroLog’s keys simultaneously. 

  
 The default alarm levels are the lower and upper 

ends of the sensors. Click Cancel Alarm to restore 
the default levels. 

 

e. Cradle time settings 

Workday hours  
 Use the up and down arrow buttons to set the daily 

period when you want the Alarm and/or the Daily 
Download to be active, or type the desired period in 
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manually. 
Alarm delay  
 Click the drop list to select the time delay between 

the time MicroLog records a reading that exceeds 
the alarm levels and the time the alarm will sound.  

  
Alarm duration  
 Click the drop list to select the time for which the 

alarm will sound before it stops automatically. 

Complete the setup 

 Click Send setup to send the new settings to 
MicroLog, which will complete the setup. Click 
Cancel if you don’t want to change the setup.  
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Note: The Send setup command erases all existing data in 
the MicroLog. 

If you set it to Timer run mode, MicroLog will wait in standby 

mode displaying , and will begin recording at the 
specified time. 
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Saving Setup 
When setting up multiple MicroLogs or Cradles use the Save 
Setup option in the Setup dialog. 

1. After you have finished the settings selection of the 
first MicroLog or Cradle and before sending the 
setup command, click Save Setup to save all the 
setup settings. 

2. Connect another MicroLog or Cradle to the PC, 

click Setup  on the main toolbar, then click 
Load Setup to load your setup settings. 

3. Change the Cradle ID.    
4. Change the comment (optional). 
5. Click Send Setup. 
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Starting recording 

Click Run  every time you want to start a new recording. 
The Run command erases all previous data in the 
MicroLog’s memory and begins recording.  

Note: If you setup the MicroLog using the Setup command, it 
will automatically begin recording, and you don’t have to click 
Run  
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Stopping recording 

Click Stop  to stop recording. In Stop mode, MicroLog 
keeps all recorded data but does not record new data. Use 
this mode to save battery power.  

Sensor calibration 
A new MicroLog comes fully calibrated. After a period of long 
use, however, you may want to recalibrate the humidity or 
the temperature sensors. 
The humidity calibration affects both MicroLog and MicroLab 
and should be carried out while MicroLog is connected to the 
PC. The temperature calibration affects only the MicroLab 
software and can be carried out regardless of whether 
MicroLog is connected to the PC. 
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Calibration password 
To prevent accidental change of the calibration, the 
calibration procedure is protected by a password. The default 
password is: 1234. To change the password: 

1. Click Logger on the menu toolbar, then click 
Calibration. 

2. Click Change Password to open the Change 
Password dialog box. 

3. Enter the current password in the Current 
Password edit box. 

4. Enter the new password in the New Password edit 
box. 

5. Enter the new password a second time in the 
Confirm New Password edit box to confirm your 
new password. 
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6. Click OK. 

Note: The password must include at least 4 characters and 
is case sensitive. 

Humidity calibration 
To calibrate the humidity sensor you will need a humidity 
chamber. 

1. Connect MicroLog to the PC 
2. Set up MicroLog to record every 10 seconds (see 

page 50). 
3. Click Logger on the menu bar, then click 

Calibration.  
4. Enter the calibration password, then click OK. 
5. Select Humidity in the Choose sensor drop list 
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6. Click Default to restore the original values 
7. Disconnect MicroLog from the PC and insert it into 

the humidity chamber. 
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8. Set the humidity chamber to the first reference 
value. Wait until the humidity level is stabilized and 
write down MicroLog’s reading. 

9. Repeat the last step with the second reference 
value. 

10. Connect MicroLog to the PC. 
11. Enter the two MicroLog values into the MicroLog 

value edit boxes. 
12. Enter the two reference values into the Reference 

value edit boxes. 
13. Click Calibrate. 
14. To restore default calibration, click Default. 
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Temperature calibration 
1. Click Logger on the menu bar, then click 

Calibration.  
2. Enter the calibration password, then click OK. 
3. Select Temperature or Ext. Temperature in the 

Choose sensor drop list. 
4. Click the Default button to restore the original 

values. 
5. Enter the two MicroLog values into the MicroLog 

value edit boxes. 
6. Enter the two reference values into the Reference 

value edit boxes. 
7. Click Calibrate. 
8. To restore default calibration, click Default. 
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Defining a custom sensor 
You can use MicroLog with any sensor that has a 0 – 20mA 
current output or a 0 – 10V voltage output. 

1. Click the Logger menu and then select Define new 
sensors to open the Define New Sensor dialog 
box. 

2. Click Add to add a new sensor to the list. 
3. In the Based on drop list, select an external sensor 

that matches your sensor’s output 
4. Type the sensor’s name in the Sensor Name edit 

box. 
5. Type the sensor’s unit in the Sensor Unit edit box. 
6. In the Calibration Values section, enter two values 

of your sensor that correspond to the base sensor 
values. For example, see the definition for a 0 – 
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100mbar pressure sensor whose output is 0 – 
20mA: 

 
Figure 4: Define New Sensor 

7. Click OK. 
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The new sensor will then appear in the External Sensor list in 
the Setup dialog box. 

Communication setup 
Communication between the PC and a MicroLog takes place 
automatically whenever you send a command to MicroLog. 
However, the Communication Setup dialog box can be used 
for more advanced communication options. 
Click on the Logger menu and then select Com setup to 
open the Communication Setup dialog box: 
If you are not using a receiver and cradle, uncheck the 
Search for Receiver and Cradle checkbox in order to 
speed up the search. 
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Figure 5: MicroLab’s Communication Setup dialog box 

The checked COM ports are available for communication. 
Click Try to connect to establish communication. 
Click Work offline to work with saved files. 
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1.4.6. Automatic Daily Download 
You can program all the MicroLogs on your line to 
automatically transmit their data to a PC every day, at a 
preset time.  
To work with this option you will need to mount the 
MicroLogs onto wireless Cradles (see page 168) and 
connect a receiver to the PC (see page 181). 

Preparing the MicroLog 

To prepare a Cradle with MicroLog system for daily 
download: 

1. Connect the cradle to the PC (see page 170).  
2. Setup the MicroLog and the cradle (see page 50). 
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Notes: 
1. Enter an identification number for the cradle in the Unit 

ID edit box. The number should be an integer between 1 
and 200 and every cradle should have a different ID 
number. (We recommend attaching a label with the ID 
number to every cradle.) 

2. The recording interval must be equal to or greater than 1 
minute for recording data from one sensor, 2 minutes for 
2 sensors and 3 minutes for 3 sensors. 

3. Check the Daily download checkbox. 
4. To set the download time and file location click 

Daily download at the bottom of the setup dialog to 
open the Daily download dialog box. 
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5. Enter the desired download time in the Download 
start time box. 
MicroLab automatically calculates and sets the 
cradles’ transmission times according to their ID 
numbers, so that the cradles will transmit the data 
successively. 

6. MicroLab stores the data files in the following folder 
by default: C:\Program Files\Fourier 
Systems\MicroLab\MicroLog Data\Daily download. 
If you want to store your data in another location 
click Browse and navigate to the desired folder. 

7. Click OK to return to the Setup dialog. 
8. Click Send setup. 
9. Repeat this procedure (except for steps d to g 

which should be performed only once) with every 
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cradle. Remember to assign a different ID number 
to each cradle. 

10. After you have finished setting up all your cradles, 
connect the RF receiver to the PC (see page 181). 

11. Click Logger on the menu bar, then click Com 
setup to open the Communication setup dialog. 

12. Make sure that the Search for Receiver and 
Cradle checkbox is checked. 

13. Click Try to connect to establish communication 
with the receiver. 

14. Place the cradles at the desired data logging 
locations. 
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Automatic download 
At the download start time the cradles should be within 300m 
of the receiver and in its line of sight. The cradles will 
automatically transmit the data one after the other according 
to their ID number. The time interval between successive 
transmissions is two minutes. 

MicroLab automatically saves the data after every 
transmission under the name: daily download [&date]. After 
the daily download has been completed, the file will 
automatically be closed. Every 24 hours MicroLab creates a 
new data file. 
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Manual transmission 

If one of the cradles fail to transmit data automatically, or if 
you need to download all data from a specific cradle (not just 
data that was recorded during working hours) press the Trs 
(Transmit) button on the right side of the Cradle (see page 
170). The cradle will then transmit all stored data to the PC. 

Viewing Daily Download data and status 
To open a daily download data file: 

1. Click Open  on the main toolbar 
2. Navigate to the folder in which the daily download 

data files are stored 
3. Double click the file name to open the file 



Chapter 1 MicroLog   

78 

MicroLab prompts to a daily summary of the 
automatic download. The summary includes a list of 
the MicroLogs that have completed their data 
download, along with their respective cradle’s 
battery level, transmission status and indication as 
to whether alarm levels were exceeded. 

4. Click OK to close the summery window and to 
display the data. 
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1.4.7. Toolbar Buttons 

Main (upper) toolbar 

 Open Opens saved files 
   

 Save Saves the data that is currently 
displayed 

   

 Print… Opens the Print Option dialog box 
   

 Export Exports the displayed data to an Excel 
spreadsheet. 
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 Run Begins data recording. 
   

 Stop Stops data recording. 
   

 Setup Opens the Setup dialog box. 
   

 Download Downloads data from the MicroLog onto 
the PC. 

   

 Graph Displays or removes the graph  
   

 Table Displays or removes the table 
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Data Map Displays or removes the Data Map 

   

 °C/°F Displays the desired unit of temperature 
   

 Alarm Displays or removes alarm levels from 
the graph 
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Graph (lower) toolbar 

 Zoom in Activates the zoom tool 
   

 Pan Activates the pan tool 
   

 Auto scale Returns the graph to full view  
   

 
Graph 
properties Opens the Graph Properties dialog box 

   

 Cursor Displays or hides the cursor 
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Chapter 2 MicroLog Plus 
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2.1. Overview 
The MicroLog Plus software enables wireless communication 
between a PC and up to 200 MicroLog devices 
simultaneously. Furthermore, real-time temperature and 
humidity readings from the MicroLog are automatically 
delivered directly to the PC. Data from external sensors can 
also be transmitted in the same manner. The complete 
MicroLog Plus system includes the MicroLog data logging 
device, the cradle that the data logger is mounted on, a small 
receiver that is placed on the PC, and the user-friendly 
software that allows for convenient central management. 
 
MicroLog Plus uses MicroLog data loggers to record 
temperature and humidity readings. The cradle that the data 
logger is mounted on is a wireless transmitter that can 
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transmit measurements to a PC from up to 300 meters. 
Since each cradle is tagged with an ID number, the cradles 
can be programmed to transmit data at various time intervals 
based on the criteria defined in their IDs. This advanced 
feature prevents data collision between two or more loggers. 
 
The MicroLab Plus software reports on the status of up to 
200 MicroLogs on a single color-coded interface. Other 
features that help automate all aspects of the industrial data 
logging procedure include the ability to store the data of each 
MicroLog, to set MicroLog alarm levels and to define 
sampling intervals, as well as any other necessary 
parameters. 
 
The Logger menu handles all communication between the 
PC and MicroLog such as programming the desired 
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MicroLog and Cradle, calibrating sensors, as well as defining 
new sensors. 
The View menu controls the various data display options. 
Online data can be viewed in multiple meters format (the 
default view), in multiple graph format, or Cradle map format. 
The stored data can be viewed on an off-line graph and 
table. 
 
The Offline Graph menu contains all the commands needed 
to format and edit the graph. 
 
The Cradle Map menu contains all the commands needed to 
setup and edit the map. 
 
The Multiple Graphs menu contains all the commands 
needed to view and edit the graphs. 
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The most common tasks and commands are available as 
buttons on the Main toolbar (upper toolbar), the Graph 
toolbar (lower toolbar) and on the Cradle map toolbar 
(lower toolbar). 

2.1.1. MicroLab Plus Default 
Window Layout 

In Meters view (the default view), the data for each MicroLog 
is displayed in a separate window in a meter. There are six 
MicroLog windows in each display. The picture below 
represents an individual MicroLog display.  
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The blue and red zones on the meters represent the low and 
high alarm levels 
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2.2. Getting Started 

2.2.1. Installation 

System requirements 
To work with MicroLab Plus, your system should be 
equipped with the following: 
 
Software 
Windows 95, or later (Windows 95 will not support USB). 
Internet Explorer 4.0, or later (you can install Internet 
Explorer 5 when you install MicroLab Plus, since it ships with 
the product). 
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Hardware 
Pentium 300 MHz or higher 
32 MB RAM (64 MB recommended) 
5 MB available disk space for the MicroLab Plus application 

 Installing the software  
1. Insert the CD into your CD drive. 
2. The installation will start automatically. Once the 

process begins, follow the on-screen instructions. 
3. In case auto run is not working, open the CD drive 

folder and double-click the setup icon, then follow 
the on-screen instructions. 

To un-install the software: From the Start menu select 
Settings / Control Panel, and use the Add/Remove programs 
function to remove the MicroLab Plus application. 
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To install the USB driver (optional): 
1. Insert the CD into your CD drive. If Installation 

begins automatically (and you have already 
installed MicroLab Plus), click Cancel to stop 
installation 

2. Connect the Cradle to a USB port on your. 
Windows will automatically detect the new device 
and open the Add New Hardware Wizard 

3. Select Specify the location of the driver, then 
click Next 

4. Select Search for the best driver for your device, 
then check the Removable Media checkbox, and 
then click Next 

Windows will automatically detect and install the necessary 
software. 
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2.2.2. Setting up the MicroLog Plus 
System  

Before you start using the MicroLog Plus System you must 
connect each Cradle to the PC using the serial 
communication cable and set it up. Follow the steps below to 
setup your system: 

1. Mount the MicroLogs onto the cradles 
2. Open the MicroLab Plus software 
3. Connect the first cradle to the PC (see page 170)  
4. Set up the first MicroLog data logger (see page 

137) 
5. Disconnect the first cradle from the PC 
6. Repeat steps 3 – 5 with each cradle 
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Note: When setting up multiple Cradles we recommend to 
use the Auto Setup tool (see page 147). 

7. Connect the RF receiver to the PC 
8. Click Logger on the menu bar, then click Com 

setup to open the Communication setup dialog. 
9. Click Try to connect to establish communication 

with the receiver. 
10. Place the cradles at the desired data logging 

locations. 

2.2.3.  Saving Data 
There is no need to save data manually as the data is saved 
automatically every half an hour in the MicroLog Data folder: 
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C:\Program Files\Fourier Systems\MicroLab Plus\MicroLog 
Data. 
You can always change the file location. 
MicroLab Plus creates a folder for each MicroLog naming it 
with the cradles ID number and stores the MicroLog's data in 
this folder.  
MicroLab Plus creates a new data file for each MicroLog 
every 24 hours at midnight. 
By default the data is saved in MicroLab Plus file format 
(.MPD – MicroLog Plus data). If you want to use the data in 
another program you can save it in text files (.CSV – comma 
separated values). The data can be saved in either one of or 
both file formats. 
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To select file format and location: 
1. Click File on the menu bar, then click Stored data 

folder… 
2. To save data in MicroLab plus file format check the 

Save MicroLab Plus files check box 
3. To change the file location, click Browse and 

navigate to the desired folder 
4. To save the data in text file format Check the Save 

text files check box 
5. To change the file location, click Browse and 

navigate to the desired folder 
6. Click OK 

Note: If you want to remove unwanted data, apply the crop 
tool (see page 133).  
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2.2.4. Activating the Sound Alarm 

Click Enable Alarm  on the main toolbar to activate 
sound alarm.  
If any MicroLog records a reading that exceeds its alarm 
levels, the MicroLab Plus's alarm will sound. 
The alarm will sound as long as the MicroLog readings 
exceeds the alarm levels. 
Click Enable Alarm a second time to disable the Alarm. 

Note: To activate the Cradle alarm, use the Setup dialog box 
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2.2.5. E-mail Alarm Notification 
MicroLab Plus can be programmed to send e-mail 
notifications to one or more e-mail addresses in any of the 
following cases: 

• Sensor alarm 
Notification that the cradle sensors have breached 
their high or low alarm level.  

• Lost cradle connection 
Notification that the cradle has either stopping 
sending data to the MicroLab Plus, or that it has 
come back online. 

• Low battery indicator 
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The notifications include the MicroLog name, the sensor 
whose alarm level was exceeded and the sensor's measured 
value. 
To setup MicroLab Plus in order to send e-mail notifications: 

1. Click File on the menu bar, then click Mail 
properties to open the Mail properties dialog box. 
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2. Check the Send e-mail notification check box. 
3. In the Server name box, type the outgoing mail 

server name (mandatory). 
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4. In the To box, type the e-mail address of each 
recipient, separating names with a semicolon (;) 
(mandatory). 

5. In the From box, type your e-mail address 
(mandatory). 

6. If your server requires authentication, enter the 
account name and password as relevant. 

7. If you require a specific subject heading in your 
emails, enter the prefix in the Subject heading 
prefix text box. 

8. Click Test to verify that the email properties were 
entered correctly. Your default email client should 
receive an email from the MicroLab Plus within 
seconds.  

9. If the email was received, click OK to exit the Mail 
properties dialog. 



 MicroLog Plus Chapter 2 

  101 

2.2.6. E-mail Events Filter 
You have the ability to filter the type of email notifications you 
receive.  
This will give you greater control over the frequency of email 
alarms generated by the software, and will in turn reduce the 
traffic to your email inbox. 

1. Go to File > Mail Properties and click Filter 
settings in the Mail properties dialog box.  

2. The e-mail Events Filter window will open up: 
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3. Select the checkboxes according to which alarm 

event you want to receive. If no checkbox is 
selected, you have effectively disabled the email 
alarm notification feature. 
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4. Click OK to apply the changes. 

2.2.7. Delaying Email Notifications 
In the email Events Filter dialog, you have the option to 
delay the sending of the email notification when your system 
goes into alarm. You can determine that if the system returns 
to normal conditions from anywhere between 2 to 100 cycles 
after the initial alarm, then an email is not sent.  
This feature is useful when wishing to minimize the number 
of alarm notifications as a result of a legitimate change in the 
environment.  

1. Go to File > Mail Properties. Click on Filter 
settings to open the email Events Filter dialog. 
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2. Select the Sensor alarm checkbox and then select 

the Send email alert only after X cycles 
checkbox. You may select between 2 and 100 
cycles. 
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If the MicroLog returns to the pre-alarm level before the 
selected number of cycles is reached then no email is sent.  
If the MicroLog is still in alarm when the number of cycles is 
reached then an email is sent. Another email will be sent 
once the logger is out of alarm. 

2.2.8. Alarm Trigger Settings 
Using this feature will enable you to trigger a cradle alarm 
only after a combination of alarm parameters has been met. 
Once these alarm levels are breached, MicroLab Plus will 
indicate that cradle is in alarm (this includes e-mail 
notification).  
 
You can define a combination of at least two of the following 
sensor types: 
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• Internal temperature sensor 
• Internal humidity sensor 
• External sensor 
• Cradle contact 

 
For example, you can determine that for those cradles 
running the internal temperature sensor and an external 
sensor, only when MicroLab Plus records alarms from both 
of these sensors will the alarm sound. 
 
However, MicroLab Plus will indicate an alarm for cradles 
recording data using sensors other than what is defined in 
the Alarm trigger settings setup. 
For example, if you selected an alarm trigger for a 
combination of the temperature, humidity and external 
sensors, but a cradle running just the temperature and 
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humidity sensors go into alarm, MicroLab Plus will indicate 
an alarm for that cradle. 
 

1. Go to File > Alarm trigger setting to launch the 
dialog box: 

2. You must select a combination of at least two 
triggers. 
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Enabling the alarm trigger applies to alarm emails, sounding 
of the alarm in the software, alarm indication in the Cradle 
map, and alarm indication in the mail MicroLab Plus window. 
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2.2.9. Changing the Temperature 
Units 

Click Toggle °C/°F button  to change the temperature 
scale from Fahrenheit to Celsius and vice versa. 

Note: To change the units in the MicroLog display, use the 
Setup dialog box or the Logger menu 

2.2.10. Display Properties 
You can change the way numbers and dates will be 
displayed on screen. 
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1. Click File on the menu bar, then click Display 
properties. 

2. In the Decimal place settings, enter the number of 
decimal places you want to display (Enter a number 
between 0 and 4) for each sensor. 

3. In the Date format settings select the desired 
format option. 

4. Click OK. 
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2.3. Online Mode 

2.3.1. Display Options 
Online data can be displayed in:  

• Meters View (the default view), in which the current 
data is displayed in meters 

• Multiple Graph View, in which the data from the last 
24 hours is displayed in graphs 

• Cradle Map format, where the MicroLogs are 
represented by color coded icons 
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2.3.2. Meters View 

Click Meters  on the main toolbar to switch to Meters 
view. 
In Meters view (the default view), the data for each MicroLog 
is displayed in a separate window in meters. The number of 
active meters in the window corresponds to the number of 
active sensors in each MicroLog. The meters are updated 
every time MicroLab Plus receives new data. 
If a MicroLog is inactive the corresponding window becomes 
gray and disabled. 
There are six MicroLog windows in each display. If you are 
using more than six MicroLogs, you can manually scroll to 
the other displays, or let MicroLab Plus do this automatically. 
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• Click Auto scroll  on the main toolbar to 
allow automatic scrolling. 

• Click Auto scroll a second time to return to manual 
scrolling. 

• Click Scroll forward   on the main toolbar to 
scroll to the next MicroLogs display. 

• Click Scroll back  on the main toolbar to 
scroll to the previous MicroLogs display. 
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2.3.3. Multiple Graphs View 

Click Multiple graphs  on the main toolbar to switch 
to Multiple graphs view. 
In Multiple graphs view, the data for each MicroLog is 
displayed in a separate window in graphs. The graphs 
display the data sets plotted versus time. In order to keep the 
graph clear and simple, only two Y-axes can be shown on 
the graph simultaneously. If there are three curves in the 
graph, one of the Y-axes will be hidden. To make this axis 
visible, select the corresponding plot with the cursor. 
You can identify the Y-axis by its color, which matches the 
plot color. 
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The graphs are updated every time MicroLab Plus receives 
new data. If a MicroLog is inactive the corresponding window 
becomes gray and disabled. 
There are six MicroLog windows in each display. If you are 
using more than six MicroLogs, you can manually scroll to 
the other displays or let MicroLab Plus do it automatically. 

• Click Auto scroll  on the main toolbar to allow 
automatic scrolling. 

• Click Auto scroll a second time to return to manual 
scrolling. 

• Click Scroll forward   on the main toolbar to 
scroll to the next MicroLogs display. 
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• Click Scroll back  on the main toolbar to 
scroll to the previous MicroLogs display 

The Cursor 
Use the cursor to view individual data recording values, or to 
reveal a hidden Y-axis. 

To display the cursor, click Cursor   on the graph 
toolbar. You can drag the cursor with the mouse to any other 
point on the plot, or to another plot altogether. 
The point coordinates of the selected data recording will 
appear in the information bar at the bottom of the graph 
window. 
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 Zooming 

1. Click Zoom in   on the graph toolbar and drag 
the cursor diagonally to select the area you want to 
magnify. Release the mouse button to zoom in to 
the selected area. 

2. Click on the Zoom in button a second time to turn 
off the Zoom tool. 

To restore auto scaling, click Autoscale  .  
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Autoscale 

Click Autoscale button  on the graph toolbar for the full 
data display. 

The Stretch/Compress axis tool 
Move the cursor onto one of graph axes. The cursor icon 
changes to double arrow symbol (↔), indicating that you can 
stretch or compress the axis scale. Drag the symbol to the 
desired location. Repeat the procedure for the other axis if 
necessary. 

To restore auto scaling, click Autoscale  .  
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Panning 
Use the pan tool after zooming view any part of the graph 
that is outside the zoomed area. 

To do this, click Pan  on the graph toolbar, then click 
anywhere on the graph and drag the graph to view another 
area. 
Click Pan a second time to turn off the Pan tool. 

Displaying alarm levels 

1. Click Display alarm level  . 
2. Select the sensor you wish to display from the 

select sensor drop list  
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2.3.4. Cradle Map 

Click Cradle Map  on the main toolbar to display the 
Cradle Map. 
In Cradle Map, each MicroLog is represented by an icon. 
Each icon carries the MicroLog’s individual ID number. When 
the MicroLog is active, the icon’s color is green. If the 
recorded data exceeds either of the alarm levels, the icon’s 
color turns to red. Move the cursor over an icon to display 
the MicroLog’s name.  
Double click on any MicroLog icon to display its meters 
window, which is identical to its window in the Meters view 
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format. To close the meters window, click Close at the upper 
right-hand corner of the window. 
Before using the Cradle Map, you must set it up and then 
lock it.  

Setting up the Cradle Map 

• Click Cradle Map  on the main toolbar to 
display the Cradle Map. 

• Click Cradle Map on the menu bar, then click 
Display toolbar to display the Cradle Map toolbar. 

• Click Lock View  on the Cradle Map toolbar to 
unlock the Cradle Map. 
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Add icons 
Add icons to match the number of MicroLogs you are using. 

• Click Add cradle  on the Cradle Map toolbar to 
add a new icon or click the down arrow button next 
to it to add a group of 5, 10 or 15 icons. 

• Use the Remove cradle button  or the down 
arrow next to it  to remove icons. 

Load a picture 
You can arrange the icons on a picture or plan of your 
working space, so that each icon represents the 
corresponding MicroLog’s actual location in the working 
space. First, load the picture into the program: 
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1. Click Load picture  on the Cradle Map toolbar 
2. Locate the picture file you want to load  
3. Double-click on the file 

Now you can click and drag the MicroLog icons to their 
desired locations on the picture.  

Lock Cradle Map 
After you have finished arranging the icons, click Lock View 

 on the Cradle Map toolbar to prevent any accidental 
change in the icon arrangement. 
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2.4. Offline Mode 

2.4.1. Offline Screen 

Click Offline   on the main toolbar to switch to Offline 
mode. 
MicroLab plus’s Offline screen consists of two parts: the 
graph and the table. The data in the table always matches 
the data that is currently displayed on the graph.  
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2.4.2.  Opening Files 
In Online mode the received data is displayed on-line both in 
graphs and in meters. 
To display previously saved data, switch to off-line mode: 

1. Click Offline   on the main toolbar. 

2. Click Open  on the main toolbar. 
3. Enter the desired cradle ID number. 
4. Select a date in the From box. 
5. Select a date in the To box. 
6. Click OK. 

That will load all the data between the dates you selected 
and display it in graph and table display. 
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2.4.3. Printing 

Printing a graph 
You can print saved data in Offline mode 

1. Click Print  on the main toolbar to open the 
Print Options dialog box. 

2. Click the graph option. 
3. Click Print to open the Print Dialog Box. 
4. Click OK. 

 Printing a table 
You can also print saved data as a table in Offline mode. 
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The table will include data as well as the MicroLog name, 
serial number and the alarm level setup. Data that exceeds 
any of the alarm levels will be highlighted by arrows.  

1. Click Print   on the main toolbar to open the 
Print Options dialog box. 

2. Click the Table option. 
3. If you want to print only part of the data, uncheck 

the check box and select the desired time and date 
in the from and to boxes. 

4. Click the Print button to open the Print dialog box. 
5. Click OK. 
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2.4.4. Graph Display 

Graph 
The graph displays the data sets plotted vs. time. 
In order to keep the graph clear and simple, only two Y-axes 
can be shown on the graph simultaneously. If there are three 
curves in the graph, one of the Y-axes will be hidden. To 
make this axis visible, select the corresponding plot with the 
cursor. 
You can identify the Y-axis by its color, which matches the 
plot color. 
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The Cursor 
Use the cursor to view individual data recording values, or to 
reveal a hidden Y-axis. 
To display the cursor, double click on an individual data point 

or click Cursor   on the graph toolbar. You can drag the 
cursor with the mouse to any other point on the plot, or to 
another plot altogether. 
The point coordinates of the selected data recording will 
appear in the information bar at the bottom of the graph 
window. 
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Zooming and panning 

Manual Scaling 

1. Click Graph Properties  on the graph toolbar 
to open the Graph Properties dialog box. 

2. Select the Scale tab, and choose the axis you want 
to scale in the select axis drop list. 

3. Un-check the Autoscale check box and enter the 
new values in the edit box 

4. In the time axis, you can either enter the time and 
date manually, or select it with the up and down 
arrow buttons. 

5. Click OK. 
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To restore auto scaling, click Autoscale  .  

Autoscale 

1. Click Autoscale button  on the graph toolbar 
for the full data display. 

2. Double-click on an individual axis to autoscale it 
separately. 

Default Zooming 
If you usually need to view a specific time frame (i.e. work-
day hours) use the Default zooming tool. You can set the 
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start and end time of the time span and then use it whenever 
you open a file or download data from the MicroLog. 
 
To set the default zoom: 

1. Click Graph Properties  on the graph toolbar, 
then click Set Default Zoom. 

2. Enter the start and end times, then click Set. 
 
To zoom to the default zoom: 

1. Click Graph Properties  on the graph toolbar. 
2. Check the Use default zoom check box and click 

OK. 
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Every file and every data recording you download will 
automatically open in the default zoom as long as the Use 
default zoom check box remains checked. 

To restore auto scaling click Autoscale  . 

Cropping the data 
Cropping enables you to trim the edges of a data set. Use it 
to remove unwanted data: 

1. Zoom to the data range you want to keep. 
2. Click Offline Graph on the menu bar, then click 

Crop. 
All data outside the zoomed area will be permanently 
removed. 



Chapter 2 MicroLog Plus   

134 

 Formatting the graph 
You can change a data line’s color, style or width. You can 
also add markers that represent the data points on the graph 
and format their style and color. 
The Y-axis color matches the corresponding plot’s color and 
will change accordingly. The time axis color can be changed 
separately: 

1. Click Graph Properties   on the graph toolbar 
to open the Graph Properties dialog box. 

2. Select the Lines tab, then select the plot or axis you 
want to format in the select plot drop list. 

3. From here you can format the line’s color, style and 
width, as well as the markers’ color and style. To 



 MicroLog Plus Chapter 2 

  135 

remove the line or the marker, un-check the 
corresponding visible check box. 

To restore the default formatting, click the Restore 
default button, and click OK 

Copying the graph as a picture 
You can copy the graph to the clipboard as a picture and 
then paste it to other Windows' programs, such as Word and 
PowerPoint: 

1. On the Offline Graph menu, click Copy graph. 
2. Open the destination file. 
3. In the destination file, right click and select paste. 
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2.4.5.  Exporting Data to Excel 

Click Export to Excel   to export the currently 
displayed data to an Excel spreadsheet. 
MicroLog Plus will open a new Excel workbook displaying 
the data along with the MicroLog info, including the MicroLog 
name, serial number and alarm levels setup. 
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2.5. Programming MicroLog 

2.5.1. Setup 
Use the Setup dialog box to view or to change the MicroLog 
and the Cradle settings 

When setting up multiple Cradles use the Auto Setup tool 
(see page 147). 
 
To save the settings for future use, activate the Save setup 
tool (see page 149).  
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1. Connect the Cradle to the PC 

2. Click Setup  on the main toolbar to open the 
Setup dialog box. 

The dialog box is made up of five sections: 
 

MicroLog info 
Comment   
  Click the edit box and type a name that will 

serve to identify the specific MicroLog (e.g. 
its location). 

S/N   
  Displays the MicroLog’s serial number 
Battery Level   
  If the indicator is in the red zone the battery 
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should be replaced. 
      
Cradle info 

Cradle ID   
  The cradle’s identification number sets the 

cradle’s transmission time in daily 
download mode. 

Battery Level   
  If the indicator is in the red zone the battery 

should be replaced. 
      
Setup 

Temperature   
  Click the Temperature check box to 

activate the internal temperature sensor 
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Humidity   
  Click the Humidity check box to activate 

the internal humidity sensor 
External   
  Click on the External check box to activate 

the external sensor option, and then select 
a sensor in the drop list. 

  
Cradle contact   
  Click the Cradle contact check box to 

activate the cradle contact 

The sensors’ current readings will appear in the labels next 
to the sensor name, once the MicroLog begins logging for 
the first time. 
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Temperature 
unit 

  

  To set the temperature unit in the MicroLog 
display, select the option you want (Celsius 
or Fahrenheit). 

  
Interval   
  Determines the logging interval, or the time 

interval between successive data 
recordings. 
The time format is hh:mm:ss. Set the time 
setting to select a recording time interval 
from between 10 seconds and 2 hours. For 
example, to set a time interval of one hour, 
five minutes and thirty seconds, click the 
hours (hh) and type 1 or use the arrows to 
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select 01, then click the minutes (mm) and 
type 5 or use the arrows, and finally, click 
the seconds (ss) and type 30 or select 30 
using the arrows. 

Timer run   
  Click the Timer run check box if you want 

MicroLog to start recording at a 
predetermined time. This option is 
convenient if you are using several 
MicroLogs at once and want them to all 
begin logging at the same time. 
Use the time and date selectors to set the 
start time. 

Cyclic run   
  In Cyclic run mode, MicroLog overwrites 

the old measurements (starting with the
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oldest one) once the MicroLog’s memory is 
full. Click the Cyclic run check box to 
operate in this mode. 

Use this mode if you intend to operate 
the system continuously.  

If the check box is clear, MicroLog will 
operate in Normal run mode and will stop 
recording when the memory is full. 

Alarm levels 
    
  Type in the desired minimum and maximum 

alarm levels. If MicroLog records a reading 
that exceeds either of these levels, the 
software's alarm will sound,  the MicroLog’s 
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LCD will start to flash and the cradle’s 
alarm will sound. 
To stop the LCD’s flashing, press either of 
its two keys. To stop the cradle’s alarm, 
press both the MicroLog’s keys 
simultaneously. 

    
  The default alarm levels are the lower and 

upper ends of the sensors. Click Cancel 
Alarm to restore the default levels. 
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Cradle time settings 
Workday hours   
  Use the up and down arrow buttons to set 

the daily period when you want the Alarm 
and/or the Daily Download to be active, or 
type the desired period in manually. 

Alarm delay   
  Click the drop list to select the time delay 

between the time MicroLog records a 
reading that exceeds the alarm levels and 
the time the alarm will sound.  

Alarm duration   
  Click the drop list to select the time for 

which the alarm will operate before it stops 
automatically. 
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Complete the setup 
  Click Send setup to send the new 

settings to MicroLog, which will complete 
the setup. Click Cancel if you don’t want 
to change the setup.  

Note: The Send setup command erases all existing data in 
the MicroLog, and it will automatically begin recording. 

If you set it to Timer run mode, MicroLog will wait in standby 

mode displaying , and will begin recording at the 
specified time. 
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2.5.2. Auto Setup 
When setting-up multiple Cradles use the Auto Setup tool. 
This tool will automatically set the minimum logging interval, 
depending on the number of units you are using, and set the 
start time for each unit. 
To perform auto Setup: 

1. Connect the first Cradle to the PC 
2. Click Logger on the menu bar, then click Auto 

Setup 
3. In the Number of units drop list select the number 

of Cradles you are setting up, then click Start 
4. Set up the first unit as you would normally 

Note: the minimum logging interval is already set in the 
Interval box and you cannot select a shorter time interval 
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5. Click OK 
6. Click Send 

After setup is completed the Auto Setup tool is ready to 
setup the second unit (notice that the title bar on the Auto 
Setup dialog has changed to ‘Unit 2’)   

7. Connect another Cradle to the PC 
8. Change the comment (optional). 
9. Click Send 
10. Repeat this procedure with every cradle 

To change the settings of a specific unit click Edit on the 
Auto Setup dialog and select the new settings before 
executing the Send command. These settings will be saved 
until the next time you change them. 
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Use the forward arrow and backward arrow buttons on the 
Auto Setup dialog to navigate to a specific unit. Notice that 
this will change the automatic sequence 

2.5.3. Saving Setup 
When setting up multiple Cradles use the Save Setup option 
in the Setup dialog. 

1. After you have finished the settings selection of the 
first Cradle and before sending the setup command, 
click Save setup. This will save all the setup 
settings. 
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2. Connect another Cradle to the PC, click Setup 

 on the main toolbar, then click Load Setup 
to load your setup settings. 

3. Change the Cradle ID    
4. Change the comment (optional). 
5. Click Send Setup. 

2.5.4.  Defining a Custom Sensor 
You can use MicroLog with any sensor that has a 0 – 20mA 
current output or a 0 – 10V voltage output. 

1. Click the Logger menu and then select Define New 
Sensors to open the Define New Sensor dialog 
box. 
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2. Click Add to add a new sensor to the list. 
3. In the Based On drop list, select an external sensor 

that matches your sensor’s output 
4. Type the sensor’s name in the Sensor Name edit 

box. 
5. Type the sensor’s unit in the Sensor Unit edit box. 
6. In the Calibration Values section, enter two values 

of your sensor that correspond to the base sensor 
values. For example, see the definition for a 0 – 
100mbar pressure sensor whose output is 0 – 
20mA: 
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7. Click OK. 



 MicroLog Plus Chapter 2 

  153 

The new sensor will then appear in the External Sensor list 
in the Setup dialog box. 

2.5.5. Sensor Calibration 
A new MicroLog comes fully calibrated. After a period of long 
use, however, you may want to re-calibrate the humidity or 
the temperature sensors. 
The humidity calibration affects both MicroLog and MicroLog 
plus and should be carried out while MicroLog is connected 
to the PC. The temperature calibration affects only the 
MicroLog Plus software and can be carried out regardless of 
whether MicroLog is connected to the PC. 
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Calibration password 
To prevent accidental change of the calibration, the 
calibration procedure is protected by a password. The default 
password is: 1234. To change the password: 

1. Click Logger on the menu toolbar, then click 
Calibration. 

2. Click Change Password to open the Change 
Password dialog box. 

3. Enter the current password in the Current 
Password edit box. 

4. Enter the new password in the New Password edit 
box. 

5. Enter the new password a second time in the 
Confirm New Password edit box to confirm your 
new password. 
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6. Click OK. 

Note: The password must include at least 4 characters and 
is case sensitive. 

Humidity calibration 
To calibrate the humidity sensor you will need a humidity 
chamber. 

1. Connect the MicroLog to the PC 
2. Set up the MicroLog to record every 10 seconds 

(see page 137). 
3. Click Logger on the menu bar, then click 

Calibration.  
4. Enter the calibration password, then click OK. 
5. Select Humidity in the Choose sensor drop list 
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6. Click Default to restore the original values. 
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7. Disconnect MicroLog from the PC and insert it into 
the humidity chamber. 

8. Set the humidity chamber to the first reference 
value. Wait until the humidity level is stabilized and 
write down the MicroLog’s reading. 

9. Repeat the last step with the second reference 
value. 

10. Connect the MicroLog to the PC. 
11. Enter the two MicroLog values into the MicroLog 

Value edit boxes. 
12. Enter the two reference values into the Reference 

Value edit boxes. 
13. Click Calibrate. 

To restore default calibration, click Default. 
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Temperature calibration 
1. Click Logger on the menu bar, then click 

Calibration.  
2. Enter the calibration password, then click OK. 
3. Select Temperature or Ext. Temperature in the 

Choose sensor drop list. 
4. Click the Default button to restore the original 

values. 
5. Enter the two MicroLog values into the MicroLog 

Value edit boxes. 
6. Enter the two reference values into the Reference 

Value edit boxes. 
7. Click Calibrate. 

To restore default calibration, click Default. 
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2.5.6.  Communication Setup 
Communication between a PC and a MicroLog take place 
automatically whenever you send a command to MicroLog. 
However, the Communication Setup dialog box can be used 
for more advanced communication options. 
Click on the Logger menu and then select Com setup to 
open the Communication Setup dialog box: 
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The checked COM ports are available for communication. 
 
Click Try to connect to establish communication. 
Click Work offline to work with saved files. 
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2.6. Toolbar Buttons 

2.6.1.   Main (Upper) Toolbar 

 

Open Opens saved files (enabled only in 
Offline View) 

      

 

Print… Opens the Print Option dialog box 
(enabled only in Offline View) 

      

 

Export Exports the displayed data to an 
Excel spreadsheet. (enabled only 
in  
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Offline View) 
      

 

Setup Opens the Setup dialog box. 

      

 

°C/°F Displays the desired unit of 
temperature 

      

 

Meters View Displays Meters View 

      

 

Multiple 
graphs View 

Displays Multiple graphs View 
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Offline View Displays Offline View 

      

 

Cradle Map Displays Cradle Map 

      

 

Scroll back Scroll to the previous MicroLogs 
display (enabled only in Online 
View) 

      

 

Auto-scroll Automatic scrolling between 
MicroLogs displays (enabled only 
in Online View) 
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Scroll forward Scroll to the next MicroLogs 
display (enabled only in Online 
View) 

      

 

Alarm Enables or disables sound alarm 

  

2.6.2. Graph (Lower) Toolbar 
  

 
Zoom in Activates the zoom tool 
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Pan Activates the pan tool 

      

 
Auto scale Returns the graph to full view  

      

 
Cursor Displays or hides the cursor 

      

 
Graph 
properties 

Opens the Graph Properties dialog 
box (only in Offline view) 

      

 
Alarm levels Displays or removes alarm levels from 

the graph 
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Alarm level selection box 

      

2.6.3.   Cradle Map (Lower) Toolbar 
In Cradle Map view, click Cradle Map on the menu bar, then 
click Display toolbar to display the Cradle Map toolbar. 
 

 
Lock Locks or unlocks Cradle Map 

      

 
Add Cradle Adds Cradle icon to Cradle Map 

      

 
Remove Cradle Removes Cradle icon from 

Cradle Map 
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Load picture Inserts a picture to Cradle Map 
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Chapter 3 The Cradle 
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3.1. MicroLog Cradle Line 

Alarm Cradle  
Accommodates an additional external sensor and 
RS 232/USB Computer Serial Interface, as well as a 
hardware alarm that operates sound alarm 
 
Catalog number DT174 

Wireless Cradle with Alarm 
A wireless cradle that can accommodate additional external 
sensor and RS 232/USB Computer Serial Interface, as well 
as a hardware alarm that operates sound alarm. 
 
Catalog number DT175 
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3.2. Operating the Cradle 
1. Place the MicroLog 
in the cradle so that its 
rear connection socket 
fits into the plug on the 
cradle. 

 
Figure 6: MicroLog and Cradle 

2a. RS232 serial 
communication 
socket 

3. External 
sensor input 

Trs button2b. USB 
socket 
4. DC power 
input LED 

indicator 
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To set up MicroLog (see Figure 6 above): 

1. Mount MicroLog onto the cradle (1). 
2. Connect the cradle to the PC using either 

serial or USB communication cable (2). 
3. Run your MicroLog’s software and use the 

setup command. 

To prepare the wireless cradle to transmit data: 

1. Set up MicroLog (see above). 
2. Connect an external sensor if needed (see 

3 in Figure 6 above). 
The cradle will automatically transmit data online or once a 
day depending on how it was set up. 
See page 84 for more on online transmission or page 72 for 
more on Daily Download. 
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When the cradle transmits data the LED indicator lights up in 
a green light. 

To manually transmit data to the PC: 

Press the Trs (Transmit) button on the right side of the 
Cradle. The Cradle will then transmit all stored data to the 
PC. 

To activate the Sound Alarm feature: 

You must connect the AC power adaptor (see 4 in Figure 6 
above). 
When the alarm operates the LED indicator lights in red light. 
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3.3. Replace the Battery  
The cradle is powered by its internal battery or by external 
AC adaptor. The cradle battery's maximum lifespan is 
approximately 100,000 transmissions (for example, if the 
recording rate is once every 15 minutes the battery's lifespan 
is approximately 3 years. 

The Cradle’s battery is a 1/2AA 3.6V 
lithium battery 

1. Unfasten the four screws at the back of the 
cradle. 

2. Carefully rotate the cradle 
3. Remove the front cover and replace the 

battery. Be sure to insert the new battery in 
the correct corresponding polarities  (look 
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for the “+” symbol next to the positive 
terminal) 

4. Replace the front cover, turn the cradle 
over and refasten the four screws at the 
back of the cradle. 

3.4. Screw Terminals 
The cradle is equipped with eight screw terminals for 
permanent connections to the cradle. These terminals 
include: 

Connection to external sensor: Identical to the cradle’s 
external sensor socket. 
Contact sensor (DT175 only): This cradle sensor (in 
addition to the usual external contact sensor) monitors Reed 
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Relay contacts and switch status (open/closed) to identify the 
correlation between phenomena such as temperature 
change and door status. This sensor’s data is stored in the 
cradle’s memory and is available only through wireless 
transmission. 

External control switch: Closes an external control circuit 
when sensor readings exceed alarm levels. Maximum load: 
30VDC, 1A.  
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Figure 7: External control switch wiring diagram 

You can wire one alarm device for High alarm level (AL – H 
terminal) and another alarm device for the low alarm level 
(AL – L terminal), or you can connect the same device to 
both terminals so it will operate whenever any of the alarm 
level is exceeded. 
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If you want to operate an alarm device that consumes more 
than 30VDC, 1A or an AC alarm device. You will have to use 
a relay. 

External power: Connection to an external 12VDC power 
supply (i.e. vehicle battery). 

To connect to the screw terminals: 

1. Unfasten the antenna screw at the top 
back of the cradle. 

2. Remove the antenna. 
3. Unfasten the four screws at the back of the 

cradle. 
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4. Remove the back cover and break the oval 
seal at the bottom of the back cover by 
pressing it with a screwdriver. 

5. Replace the back cover. 
6. Carefully rotate the cradle. 
7. Remove the front cover. 
8. Insert the external wires through the oval 

opening you have broken at the back 
cover and fasten them to the appropriate 
screw terminals (see picture and table 
below) 

9. Replace the front cover, turn the cradle 
over and refasten the four screws at the 
back of the cradle. 

10. Replace the antenna and fasten the 
antenna screw. 
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Figure 8: Cradle’s screw terminals 

The table below lists the various screw terminals according 
to their labels (from left to right) that are printed above the 
terminals: 
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Label (Left to right)  Function 
   
1 AN 
2 PWR  External sensor (+Ground) 
   
3 DOOR 
4 GND  Contact sensor (online only) 
   
5 AL–H 
6 AL–L  External control switch (30VDC, 1A) 
   
7 GND 
8 +12V  External power 
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Chapter 4 The Receiver 
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4.1. Overview 
The Receiver is designed to receive wireless data from 
remote MicroLog cradles or Repeaters and send it to your 
computer. 

The Receiver is equipped with two LED indicators to show 
Receiver status and is powered by an AC/DC mains adaptor. 

4.2. Getting Started 

4.2.1. Locating the Receiver 
Locate the Receiver near the computer. You can either place 
it on a tabletop or hang it on the wall. 
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Serial socket 

4.2.2. Receiver Layout 

 
 

Figure 9: Receiver layout 

Antenna 

RF LED 
Indicator

Data LED 
Indicator 

9 – 12 V 
DC Input 

USB socket 
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4.2.3. Powering the Receiver 
The receiver must be connected to the mains when in use. 
The rechargeable battery functions only as a backup in the 
event of electricity failure. 
Connect the supplied AC/DC adaptor to the mains, and then 
connect it to the 9-12V DC input at the bottom of the 
Receiver (refer to Figure 9 above). 
The Receiver is now ready to receive data and transfer it to 
the computer. 

4.2.4. Connecting the Antenna 
Screw the supplied whip antenna to the SMA antenna socket 
at the top of the Receiver (refer to Figure 9 above). If the 
Receiver is lying on a tabletop, use the hinge to bend the 
antenna to an upright position. 
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Note: You can also use Fourier Systems’ magnet antenna 
(refer to Chapter 5). 

4.3. LED Indicators 
Two LED indicators are used to indicate the Receiver’s 
status by flashing. The indicators are located on the 
Receiver’s front panel. The upper LED is marked DATA and 
the lower LED is marked RF.  

The RF indicator lights up red whenever the Receiver 
receives RF carrier of the operating frequency (433 MHz in 
Europe or 915 MHz in the US). 

The DATA indicator lights up green whenever the Receiver 
receives MicroLog data. 
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The upper LED also represents the power supply and lights 
up yellow whenever the Receiver is connected. 

If the Receiver is disconnected from the mains power supply, 
the DATA indicator lights up yellow and keeps blinking every 
two seconds as long as the external power is down. The 
backup battery will allow for five hours of operating. 
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4.4. Beeper 
The Receiver is equipped with a built-in beeper that beeps 
whenever the Receiver receives a single data point. If the 
Receiver receives daily download data, it beeps when 
transmitting it to the next leg. 

To turn the beeper on and off: 

1. Connect the Receiver to the computer. 
2. Run MicroLab or MicroLab Plus software. 
3. Click Logger on the main menu, then click 

Receiver beeper on. 
To change the beeper’s status, repeat step 3 above. 
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Chapter 5 External Magnet Antenna 
For use with the Cradle and/or receiver 
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5.1. Overview 
The external antenna is equipped with a magnet clamp for 
easy mounting on metallic surfaces. Just plug the antenna to 
the Cradle or Receiver, place the magnet antennae in a 
location where transmission is most accessible (for example, 
on the roof of a truck) and you are ready to go. 
Use the external antenna in cases where the: 
• Cradle or Receiver is located in metal chambers (for 

example, in refrigerators). 
• Cradle or Receiver is located indoors for protection from 

harsh environmental conditions and rain.  
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The external antenna is designed for 914MHz and 433MHz 
carriers. The antenna adds a 1-3dB gain to the Transmitter-
Receiver path. With the use of an external antenna on both 
Cradle and Receiver we manage to maintain a constant data 
reception from the Cradle at distances of 360m with no line 
of sight. 
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5.2. Connecting the Antenna to the 
Receiver 

To use the external antenna, simply screw the antenna to the 
SMA connector at the top of the receiver (refer to Figure 9 on 
page 183). 

5.3. Connecting the Antenna to the 
Cradle 

All cradles produced after March 2003 have an SMA 
connector on their right side of the cradle. 
To use the external antenna, simply screw the antenna to the 
SMA connector. 
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. 

Figure 10: MicroLog with Cradle 

SMA external 
antenna 
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5.4. Preparing the Cradle to work 
with the External Antenna 

The cradle is equipped with an internal jumper that connects 
the transmitter either to the built-in wipe antenna or to the 
external magnet antenna. 
To change the jumper position:  

1. Unfasten the four screws at the back of the 
cradle. 

2. Carefully rotate the cradle. 
3. Remove the front cover. 
4. Place the jumper in the desired position. 
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Figure 11: Changing the jumper position 
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The jumper connects the middle pin either to the right-hand 
pin marked INT (internal antenna) or to the left-hand pin 
marked EXT (external antenna). 

 
Figure 12: INT and EXT Antenna pins 
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5. Replace the front cover, turn the cradle 
over and refasten the four screws at the 
back of the cradle. 
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Chapter 6 External Sensors 
MicroLog works with the following external sensors:   

6.1.  Temperature -50°C to 100°C 
This MicroLog sensor takes external temperature 
measurements over a wider range than the internal 
temperature sensor with a faster response time than the 
internal sensor.  
Specifications: 
Range:  -50°C to 100°C 
Resolution: Better than 1°C between -20°C to 75°C 
Accuracy: ±2% of reading 
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Probe Length:  150 mm 
Probe OD:  3.2 mm 
Probe Max. Temperature: 150°C 
Cable Max. Temperature:  80°C 

6.2. Temperature -10°C to 10°C 
This is a high-precision temperature sensor designed for 
refrigeration monitoring 
Specifications: 
Range:  -10°C to 10°C 
Resolution: 0.2°C 
Accuracy: ±0.2°C 
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Probe Length:  50 mm 
Probe OD:  4 mm 
Operating Temperature: -10°C to 50°C 

6.3. Temperature -100°C to 120°C 
PT100 adapter 

This is a wide range temperature adapter designed to 
process PT100 output   
Specifications: 
Range:   -100°C to 120°C 
Resolution: 1°C 
Accuracy:  ±1°C 
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Adapter operating Temperature: 
   -10°C to 50°C 
Screw terminals for PT100 connection 

6.4. Voltage Sensor 
This is a general sensor that will measure any device or 
transmitter that produces a linear analog output of 0-10V. 
The voltage can easily be converted to the correct measured 
units with the help of the MicroLab software. 
Specifications:  
Range:  0-10V 
Resolution: 0.05V  
Accuracy: ±3% before calibration  
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Input Impedance: 3MΩ 
Calibration: Two point calibration 
OV protection: +30V 

6.5. Current Sensor 
This MicroLog external sensor can sample any device or 
transmitter producing a linear current of 0-20mA. The 0-
20mA can be converted to the correct measured units using 
the MicroLab software’s Calibration option. 
Specifications: 
Range:  0-20mA 
Resolution: ±0.1mA 
Accuracy: ±3 before calibration 
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Calibration: Two point calibration 
OC protection: 55mA 

6.6. pH Sensor 
This external sensor monitors the pH level of liquids. 
Specifications: 
Range:  1-14pH 
Resolution: 0.116pH 
Accuracy: 5% of reading 
Calibration: Single point, done with a small trimmer on 

the sensor. 
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6.7. Contact Adapter 
This MicroLog sensor monitors Reed Relay contacts and 
switch status (open/closed) to identify the correlation 
between phenomena such as temperature change and door 
status. 
Specifications: 
Range:  open/close 
Connector: Screw Terminal 
Cable Length:  2.5m 
Internal Pull-Up Resistor: No need for external power source 
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Specifications 

MicroLog 
Models: 

EC600 temperature and external sensor data logger 
EC650 temperature, relative humidity and external 
sensor data logger  

Inputs:  

Two built-in sensors: 
Temperature: -30°C - 50°C (resolution 0.5°C, accuracy 
±0.6°C) 
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Relative Humidity: 0-100% (resolution 0.5%, accuracy 
±3%)  

External sensor:  
Voltage  0 to 10V 
Current  4 to 20mA 
Temperature -50°C to 100°C 
pH   0 to 14pH 
Contact  Open / Closed 

Outputs: 

Two digit 7-segment LCD 
IRDA interface to HP-printer and host computer 
RS232 serial communication at 19,200 bps 
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Memory Capacity: 

16,000 recording samples  
Power Supply: 

Internal Lithium Battery: 3.6V 1.2AH 1/2AA 
Battery Life - approximately two years, replaceable 
(Lifespan may vary with use of external sensors)  

Sampling Rate: 

User defined: from once every 10 seconds to every 2 
hours  

Dimensions: 

Diameter: 72mm  
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Thickness:  22.9mm 
Weight:  55gr  

Standards 

Water and dust proof IP65 standard, compliance for 
EC600 model 
CE and FCC standard compliance 

MicroLog Cradle 
Audible alarm. 

Serial communication channels: 

RS232 at 19.2Kbps 
USB at 1.5Mbps  
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Memory Capacity (DT175 only): 

2,000 recording samples 
Connectors: 

4-pin flat connection to the MicroLog 
4-pin flat connection to any MicroLog external sensor 
Screw terminal for External DC supply, Connection to 
external sensor, External control switch and additional 
Contact sensor (the additional contact sensor is 
available in DT175 only)  

Power supply: 

Internal lithium battery: 3.6V 
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Battery Life - approximately 100,000 transmissions, 
replaceable 
External: 6-30V, minimum 300mA  

RF transmission (DT175 only): 

EMC conformant to ETS 300-683  
 Type approved to ETS 300-220. Usable range to 300m 
(75m indoors) 418 (UK) & 433.92MHz (Euro) versions  
1mW on 418 MHz, 10mW on 433.92MHz 
2nd harmonic <-60dBc 
16cm wipe antenna  

CE and FCC standard compliance 
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MicroLog Plus Receiver 
Usable range to 300m (75m indoors) 
One RS232 communication port to the computer’s  

Power supply: 

External AC/DC 6V adapter  
Red LED indicating RF signal 
Green LED indicating valid data being received 
Type approved to ETS 300-220  
CE and FCC standard compliance 
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Software 
MicroLab software 

Downloads data from MicroLogs 

Graph and table displays 

Displays alarm levels on graph 

Setting up MicroLog: 

Define sensors 
The ID number of each of the cradles 
The alarm levels of each data logger 
Comment (name) for each data logger 
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Sampling rate: From once every 10 seconds to every 2 
hours 

Automatic daily download: 

Wireless daily download from up to 200 MicroLogs 
Automatic data saving 
Daily status report 

System requirements 
Software 

Windows 95 or later 
Internet Explorer 4.0 or later  
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Hardware 
Pentium 300 MHz or higher 
32 MB RAM (64 MB recommended) 
5 MB available disk space for the MicroLab 
application 

MicroLab Plus software 

Wireless communication with up to 200 MicroLogs: 

Real-time temperature and humidity and external 
sensor readings 
Displays data in meters or on graphs 
Visual and sound alarm when the data reading exceeds 
a minimum or maximum alarm threshold for 
temperature or humidity 
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E-mail alarm notification 
Displays battery level 
Automatic data saving to an Excel file 
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Setting up MicroLog: 

Define sensors 
Sensor calibration 
The ID number of each of the cradles 
The alarm levels and properties of each data logger 
Comment (name) for each data logger 
Sampling rate: From once every 10 seconds to every 2 
hours.  

System requirements 
Software 

Windows 95 or later 
Internet Explorer 4.0 or later  
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Hardware 
Pentium 300 MHz or higher 
32 MB RAM (64 MB recommended) 
5 MB available disk space for the MicroLog Plus 
application 
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